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chapter 1

Using This Guide
Thank you for purchasing DigiDrive® FireWire. 
DigiDrive FireWire drives are optimized for use 
with Digidesign Pro Tools and are ideal for re-
cording, playback, and storage of Pro Tools ses-
sions and audio files.

About This Guide

The information in this guide is a supplement to 
the hard drive installation instructions found in 
the setup guide that came with your Digidesign 
system. 

This guide contains DigiDrive-specific installa-
tion and configuration instructions and other 
information as follows:

Chapter 2, “DigiDrive FireWire Overview” de-
scribes the front and rear panels of the DigiDrive 
and its controls and indicators. It also includes 
information on rack-mounting options, han-
dling recommendations, and configuration re-
quirements.

Chapter 3, “Installation” provides step-by-step 
instructions for connecting DigiDrive FireWire 
drives to your Digdesign system. 

Chapter 4, “Performance Guidelines” docu-
ments performance guidelines for FireWire hard 
drives.
Chapter 5, “Formatting and Maintaining DigiDrive 
FireWire Drives on Mac OS” covers manage-
ment and troubleshooting issues specific to the 
Macintosh, including how to handle, check, 
and erase a DigiDrive and how to resolve basic 
problems that might occur during installation 
and operation.

Chapter 6, “Formatting and Maintaining DigiDrive 
FireWire on Windows 2000” covers management 
and troubleshooting issues specific to Windows 
2000, including how to create partitions, create 
drives, how to format drives, and how to resolve 
basic problems that might occur during installa-
tion and operation.

Appendix A, “Specifications” provides physical 
dimension, environmental, power, and power 
cord specifications for the DigiDrive FireWire 
drive.

If You Need Help

If you are having trouble setting up and config-
uring the DigiDrive, try the following:

1  Retry the action, carefully following the in-
structions given for that task in this guide.

2  Check the documentation that came with 
your hardware for maintenance or hardware-re-
lated issues.
Chapter 1: Using This Guide 1
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3  See the additional technical resources on the 
web at:

http://www.digidesign.com/support/techsup-
port.html

Digidesign has both product information and 
technical support on-line via the World Wide 
Web. In addition, there are many user forums 
which Digidesign encourages, but does not 
sponsor. For the most current, accurate informa-
tion about Digidesign products, please browse 
Digidesign-sponsored forums at the Digidesign 
Web site (www.digidesign.com).
DigiDrive FireWire Guide



                
chapter 2

DigiDrive FireWire Overview
The DigiDrive FireWire drive supports the IEEE 
1394 high-speed serial bus specification, com-
monly known as FireWire, for data storage and 
retrieval. 

DigiDrive FireWire drives use innovative, pat-
ented QuietDrive™ sound-dampening technol-
ogy, making them some of the fastest and quiet-
est drives available today. 

FireWire Features
FireWire and other IEEE 1394 implementations 
provide: 

• A simple common plug-in serial connector on 
the back of your Pro Tools workstation and on 
many different types of peripheral devices

• A thin serial cable 

• A high-speed rate of data transfer that accom-
modates audio editing and other multimedia 
applications 

• HotPlug and plug-and-play capability

• The ability to daisy chain devices together in a 
number of different ways without terminators 
or complicated setup requirements
DigiDrive FireWire Features
The DigiDrive FireWire drive is designed to rack 
mount in an industry-standard 19-inch rack 
when used with the rack-mount option. Multi-
ple drives can also be stacked on top of one an-
other to occupy a minimum amount of desk 
space. 

DigiDrive FireWire drives have a 3.5-inch form 
factor and support these performance features:

The drive enclosure provides the cooling, 
power, and cabling connections.

DigiDrive features

Feature Description

Data 
Transfer 
Rate

up to 400 Mb/s 

Bus ter-
mination 
required

No

Bus type Serial (IEEE 1394)

Cable 
type

Twisted pair (six wires: two power and 
two twisted-pair sets)

Network 
topology

Daisy-chain
Chapter 2: DigiDrive FireWire Overview 3
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Controls and Indicators
The front of the DigiDrive FireWire drive has 
controls and indicators for turning on the drive 
and determining its operating status. The back 
panel contains an AC power connector, ventila-
tion openings to promote air flow for cooling, 
and connectors for the FireWire interface cables.

Front Panel

The label on the left side of the front panel 
shows the drive’s capacity and type (for exam-
ple, FireWire, 80-GB capacity).

The label on the right side of the front panel, 
and the red translucent handle, indicate that 
this model provides a FireWire interface. These 
indicators distinguish the DigiDrive FireWire 
drive from other models such as the DigiDrive 
SCSI drive.

The front panel Power switch turns the drive’s 
internal power supply on and off. The ventila-
tion openings provide air flow for the drive 
while it is operating. Do not block these open-
ings. Keep them clear of dust. 

Three LEDs indicate the status of the drive. 
These LEDs indicate the following:

DigiDrive FireWire drive front panel

The DigiDrive FireWire drive front panel 
displays the Apple FireWire logo on the 
technology label. DigiDrives without the 
FireWire logo do not support IEEE 1394 
functions.

power LED

power switch

thermal LED ventilation openings stacking feet

technology label

activity LED

product identification label
DigiDrive FireWire Guide
Back Panel

The DigiDrive FireWire drive back panel has two 
6-pin IEEE 1394 FireWire connectors and a 
power connector. Use the FireWire cables to 
connect drives to your Pro Tools workstation. 
An internal fan pushes air through the enclo-
sure (using the ventilation openings), from 
front to back, to cool the drive. The power con-
nector is for attaching a power cable.

DigiDrive LEDs

LED Description

Power 
LED

The green LED is on when the drive is 
turned on. 

Activity 
LED

The yellow LED is on when the drive is 
turned on and flickers as data is trans-
ferred to and from the drive.

Thermal 
LED

The red LED is on when the thermal 
overload circuitry on the board senses 
that the temperature inside the 
DigiDrive FireWire drive is too high. The 
LED may light for the following rea-
sons:
• Air flow through the drive is blocked.
• The internal fan has failed.
• Outside ambient temperature is too 

hot.

Operating the DigiDrive FireWire drive for 
extended periods of time with the thermal 
indicator on reduces the life expectancy of 
the drive and may void its warranty.

DigiDrive FireWire drive back panel

ventilation openings

power connector

6-pin FireWire connectors



                             
Rack Mounting Option
Digidesign offers an optional rack-mounting kit 
(Digidesign model number MH163) that allows 
you to mount a pair of DigiDrives in a rack. The 
kit supports two drives mounted side-by-side, 
occupying two rack units in an industry-stan-
dard sized rack. 

DigiDrives are designed so that all controls and 
indicators are accessible when mounted. In-
structions for mounting the drives are included 
with the kit.

Handling the DigiDrive
Though DigiDrives are ruggedly constructed, 
their internal mechanisms can be damaged if 
handled carelessly. Follow these tips for care and 
handling of your DigiDrive to help ensure a 
long operating life.

When a DigiDrive is off:

◆ Don’t drop a DigiDrive when moving it.

◆ Keep the area around the DigiDrive free of 
dust and dirt.

◆ If stacking DigiDrives, limit stack height to 
four drives to reduce the likelihood of the stack 
tipping over.

When a DigiDrive is on:

◆ Do not shake or jar the drive. This can damage 
the read/write heads or the magnetic coating on 
the drive platters.

Do not open a DigiDrive enclosure. There 
are no user-repairable parts inside. Opening 
the enclosure voids your warranty and your 
right to have the drive mechanism repaired 
without charge.
◆ Do not turn off the power to a drive while its 
icon is visible on the Macintosh desktop. This 
could cause directory structure problems and 
create incomplete files.

◆ Do not turn off the power to a drive while an 
application is reading or writing data to the 
drive. This could cause directory structure prob-
lems and create incomplete files.

◆ Never disconnect cables while the drives are 
running. Shut down the system and turn off the 
drives before disconnecting cables.

Configuration Requirements
The FireWire cabling standard requires that 
each DigiDrive FireWire drive be within 14.76 
feet (4.5 meters) of the next bus connector. The 
maximum total bus length cannot exceed 236 
feet (72 meters).

Digidesign has qualified configurations contain-
ing a maximum of two DigiDrive FireWire 
drives daisy-chained to a Pro Tools workstation 
using Digidesign supplied cables.

The latest compatibility information is available 
online at www.digidesign.com.
Chapter 2: DigiDrive FireWire Overview 5
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chapter 3

Installation
This chapter explains how to connect a 
DigiDrive FireWire drive to your computer.

Unpacking the DigiDrive 
FireWire Drive
Unpack the DigiDrive FireWire drive and check 
the contents of the package to ensure that all 
parts are included. The package should contain:

• One DigiDrive FireWire drive

• One power cable

• One Digidesign 12-inch, FireWire daisy-chain 
cable

• This guide

• Registration card

After unpacking the DigiDrive FireWire drive, 
set up and connect it as described in this chap-
ter. Later you will use the disk management 
tools provided by your computer’s operating 
system to prepare the DigiDrive FireWire drive 
for use with Pro Tools.
Stacking DigiDrives
If you have more than one DigiDrive you may 
want to stack them so that they take up a mini-
mal amount of desk space. DigiDrives have in-
terlocking brackets attached to their sides to al-
low stable and secure stacking. 

The interlocking stacking brackets allow three 
methods of stacking:

Gravity Stacking

Gravity stacking allows you to place one drive 
on top of another. An indentation in the base of 
the interlock stacking brackets increases stabil-
ity when compared to simply stacking drives 
without the bracket. This method is only recom-
mended when temporarily stacking a DigiDrive 
from one system to another.

Temporary Interlock 

Temporary interlock provides a more secure 
method of stacking DigiDrives. Grooves in the 
interlocking stacking brackets stabilize the 
drives. An indentation in each groove settles the 
drive in the correct position. 

To temporarily interlock DigiDrives:

1  Place the first (bottom) DigiDrive on a stable 
surface.
Chapter 3: Installation 7
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2  Position a second DigiDrive slightly over and 
behind the first drive.

3  Slide the top DigiDrive forward so the slots in 
the four top drive interlock stacking brackets 
slide over the four tabs on the bottom drive in-
terlock stacking brackets.

Permanent Interlock

Permanent interlock is a more long-term 
method of stacking DigiDrives. After interlock-
ing the drives, a locking plate is positioned so 
that the top and bottom drives are secured in 
place. 

To permanently interlock DigiDrives:

1  Perform steps 1, 2, and 3 as described in “Tem-
porary Interlock” on page 7.

2  Remove the top locking plate screw on both 
sides of each drive.

Interlocking DigiDrives

DigiDrive locking plates

interlock

slots

tabs

stacking feet

remove top

loosen bottom

locking plate screws

locking plate screws
DigiDrive FireWire Guide
3  Loosen the bottom locking plate screw on 
both sides of each drive.

4  Swing the locking plate on each side of the 
bottom drive 90 degrees (to a horizontal posi-
tion) and tighten the locking plate screw.

5  Swing the locking plate on the top drive 180 
degrees so that the upper hole in the top locking 
plate aligns with the upper hole in the bottom 
drive.

6  Replace the screw into the top hole in the bot-
tom drive so that the top and bottom drives are 
secured to each other.

7  Replace the remaining screw into the top hole 
in the top drive.

8  Repeat steps 5 through 7 for the other side of 
the top drive.

9  Repeat this entire procedure if stacking a third 
and fourth drive.

Bottom drive locking plate

Secured DigiDrives

bottom locking plate
turned 90 degees

store extra screw here

top locking plate
turned 180 degees



            
When more than four drives are used, consider 
creating two drive stacks.

Connecting Cables
When connecting a DigiDrive FireWire drive to 
your computer, connect the FireWire cable be-
tween the FireWire connectors on the rear of the 
drive and your computer. Refer to the illustra-
tion.

The FireWire standard supports hot-pluggable in-
stallation of FireWire devices. This means that 
you do not have to turn off your computer be-
fore connecting the FireWire cables.

See the documentation supplied by your 
computer manufacturer for the location of 
the FireWire connector on your computer.

Connecting FireWire cables

To avoid possible disk errors and file cor-
ruption, always quit Pro Tools and make 
sure the DigiDrive is not in use before dis-
connecting it from the computer.

power cables
to gounded

power source

second
DigiDrive

FireWire

first
DigiDrive

FireWire interface
cable to Pro Tools workstation

daisy-chain cable
Configuration Requirements
Keep in mind the following when configuring 
DigiDrive FireWire drives:

• The FireWire cable between the Pro Tools 
workstation and the first drive (or between 
any two ports) cannot exceed 14.76 feet (4.5 
meters).

• The total FireWire cable from the system to 
the last drive cannot exceed 236 feet (72 
meters).

• A 12-inch (30.5 cm) FireWire cable ships with 
each DigiDrive FireWire drive to daisy-chain 
the drives.

• Either FireWire connector on the drive can be 
used to connect to the system and other 
drives.

• Maximum compatibility is achieved when 
your system has dual FireWire ports. Daisy-
chain DigiDrive FireWire drives to one port 
and use the other port for cameras and video 
decks.

• DigiDrive FireWire drives do not require a ter-
minator.
Chapter 3: Installation 9
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Connecting DigiDrive FireWire 
Drives to Other Computers
After you have formatted your DigiDrive 
FireWire drives, you can move the drives from 
one system to another without turning the com-
puters off. However, both computers must use 
the same operating system for which you have 
formatted the DigiDrive.

Hot Plug Removal

Make sure the DigiDrive FireWire drive is not be-
ing accessed by a software application before 
disconnecting it from your computer. (The 
drive’s yellow Activity LED flickers when the 
drive is accessed.)

To disconnect a DigiDrive FireWire drive from a 
Windows 2000-based computer while the 
computer is running:

1  Click the HotPlug/Eject icon on the right side 
of the taskbar. A pop-up menu appears with a 
list of attached DigiDrive FireWire drives.

2  From the pop-up menu, choose the DigiDrive 
FireWire drive you want to remove.

3  Turn off the DigiDrive FireWire drive and dis-
connect it from the computer.

See “Formatting DigiDrives” on page 13 
and “Creating Primary Partitions and For-
matting Drives” on page 20 for information 
on formatting DigiDrives.
DigiDrive FireWire Guide
To disconnect a DigiDrive FireWire drive from a 
Macintosh computer while the computer is 
running:

1  On the Macintosh Desktop, drag the 
DigiDrive FireWire drive icon to the Trash. 

2  Turn off the DigiDrive FireWire drive and dis-
connect it from the computer.

Hot Plug Addition

The DigiDrive FireWire drives can be connected 
to a computer without turning the computer 
off. 

To connect a DigiDrive FireWire drive to a 
computer while the computer is running:

1  Quit Pro Tools and make sure all currently 
open applications are idle. 

2  Plug the power cord into the DigiDrive 
FireWire drive.

3  Connect the FireWire cable between the Digi-
Drive FireWire drive and the computer.

4  Turn on the DigiDrive FireWire drive. The 
drive’s icon appears after several seconds.

On Windows systems, the DigiDrive FireWire 
drive appears on the taskbar as a HotPlug/Eject 
icon.

On Macintosh systems, the DigiDrive FireWire 
drive icon appears on the desktop.

If you do not drag the DigiDrive icon to the 
Trash before disconnecting the drive from 
the Macintosh, a system error may occur.
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Performance Guidelines
Performance Guidelines
Pro Tools systems have strict hard drive require-
ments. The recording and playback perfor-
mance of your system depends on several fac-
tors.

Factors affecting system performance:

◆ Hard drive performance. The faster the drive’s 
seek time, the better. The data transfer rate re-
quired for 32-track, 24-bit performance (at a 
sample rate of 44.1 kHz) is 4.04 MB per second 
of sustained throughput. This rate must be re-
flected in the performance of one or more of the 
drives and SCSI subsystems in your computer to 
achieve this level of performance.

◆ CPU speed. The faster the CPU, the better. 
Overall system performance can affect track 
count. 

◆ Size of your DAE Playback Buffer. See the 
Pro Tools Reference Guide for an explanation of 
DAE Playback Buffer size and its effect on system 
performance.

◆ Edit density (the number of edits per second) 
affects the number of different files that a drive 
must seek. Sessions with high edit density are 
more demanding on hard drives than sessions 
with lower edit density. For this reason, drive 
performance may depend on the session you are 
playing. While there is no specific definition of 
high or low edit density, most Pro Tools users 
will work with low to moderate edit density ses-
sions. However, extensive use of crossfades, or 
certain processing such as using Beat Detective 
can create high levels of edit density in a ses-
sion.

If you suspect that you are receiving poor drive 
performance due to high edit density, use the 
Consolidate command for heavily edited tracks. 
This will reduce the number of seeks required.

In general, you can obtain the following perfor-
mance goals with the following setups:

To achieve up to 24 simultaneous tracks of 16- or 
24-bit audio with heavy edit density you will need:

◆ One or more DigiDrive FireWire drives con-
nected to your FireWire ports.

If your sessions have high-density edits (for ex-
ample, 3 edits per second across all tracks, all 
with crossfades), you will need to distribute 
your audio files over more than one hard drive 
to allow for increased demand on drive seek ca-
pability.
Chapter 4: Performance Guidelines 11
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To achieve up to 48 simultaneous tracks of 16- or 
24-bit audio with high edit density you will need:

◆ Two or more DigiDrive FireWire drives con-
nected to your FireWire ports.

Digidesign testing has shown that certain oper-
ating systems will not support more than two 
FireWire drives connected to a Pro Tools work-
station. For the latest compatibility information 
and performance requirements, check online at 
www.digidesign.com.

Additional Hard Drive Performance Tips:

• Use two drives. You can improve performance 
by allocating audio files between multiple 
DigiDrive FireWire drives.

• Avoid distributing audio files within a session 
over different partitions on the same drive. 
This will slow drive performance.

• Minimize cable length. The IEEE 1394 
FireWire cabling standard requires that each 
FireWire drive be within 14.76 feet (4.5 
meters) of the next bus connector. The maxi-
mum total bus length cannot exceed 236 feet 
(72 meters). Note that cable length includes 
the cabling inside the drive enclosures them-
selves—which can be up to 12 inches in 
length.

• Do not spread sessions across different types 
of drives. For example, if your session has au-
dio on a FireWire drive, you cannot also have 
audio for that session on a SCSI drive or an in-
ternal drive. Spreading audio across different 
types of drives (and therefore different data 
busses) will cause errors.

For details on allocating tracks to drives, re-
fer to the Pro Tools Reference Guide.

Round Robin Disk Allocation is not sup-
ported with partitioned hard drives.
DigiDrive FireWire Guide
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Formatting and Maintaining DigiDrive 
FireWire Drives on Mac OS
To use your DigiDrive FireWire drive on a Mac-
intosh computer, you must first format it. Once 
you have done this, you can keep your 
DigiDrive in peak operating condition by per-
forming maintenance operations and checks on 
a regular basis.

To help you do this, this chapter contains the 
following sections:

◆ Formatting DigiDrives

◆ Initializing DigiDrives

◆ Diagnosing and Treating Problems

◆ Troubleshooting

Formatting DigiDrives
Once you have connected your DigiDrive 
FireWire drive to the Macintosh system, you 
must format it. DigiDrive FireWire drives will 
not appear on your computer’s desktop until 
properly formatted.

Mac OS 9 (including 9.04, 9.1, and 9.2.1) allows 
you to create a single partition on your 
DigiDrive FireWire drive.

To format a DigiDrive FireWire drive on a 
Macintosh operating system:

1  Start up your Macintosh computer. 
Chapter 5: Formatti
2  Turn on the DigiDrive FireWire drive power 
switch. 

3  When the Initialization dialog box appears, 
type a name for the DigiDrive FireWire drive.

4  From the Format menu, choose Apple HFS+ 
and Click Initialize.

5  When the Warning dialog appears, click Con-
tinue.

Once the drive is initialized, the DigiDrive 
FireWire drive icon appears on the desktop with 
the name you typed.

Initializing a DigiDrive

Drives formatted with standard HFS may 
have problems copying files over 2 GB.

Warning dialog
ng and Maintaining DigiDrive FireWire Drives on Mac OS 13
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Initializing DigiDrives
At some point you may want to initialize your 
DigiDrive to remove all data stored on it. Initial-
izing re-creates the partition map and directory 
structure, improving overall drive performance. 
It is best to initialize drives when you are be-
tween projects, or when the media files and 
other data on the drives are no longer needed.

To initialize a DigiDrive:

■ In the Finder, select the DigiDrive icon, then 
choose Erase Disk from the Finder’s Special 
menu.

Diagnosing and Treating 
Problems
When problems occur with a drive, they are of-
ten problems with the file system written on the 
drive. The file system consists of data structures 
that hold critical information about the files 
stored on a drive. Some of these data structures 
allow your drive to be recognized as a Macintosh 
volume.

Initializing a drive destroys all the data on 
the drive. Make sure you back up all impor-
tant data on the drive to another medium 
(such as CD-ROM) before you initialize the 
drive.
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Periodic use of utilities such as Disk First Aid™ 
and Norton Disk Doctor™ will maintain the file 
system and its data structures on your 
DigiDrive and help ensure optimum, trouble-
free performance.

File system errors tend to increase over time. 
They should be fixed as soon as you discover 
them. File system errors are generally caused by 
system crashes, improper system shutdowns, 
and power failures. They should not be inter-
preted as a precursor to a mechanical drive fail-
ure.

Following are examples of common file system 
structure errors that Norton Disk Doctor can di-
agnose and, in most cases, fix without damaging 
data:

◆ Master directory block errors

◆ Alternate master directory block errors

◆ Leaf node errors

◆ Header node errors

◆ Volume bit map errors

◆ Files with bad creation dates

Every drive has a directory or index that informs 
the system where files reside. If the directory be-
comes damaged or corrupted, the system will 
not be able to locate the files.

Make sure that your disk maintenance soft-
ware specifically supports FireWire (IEEE 
1394) drives. Using incompatible software 
can cause permanent loss of data. Norton 
Disk Doctor, for example, must be version 
6.0 or later.



Using Disk First Aid

Disk First Aid is a drive directory structure repair 
tool from Apple Computer, Inc. included with 
each Macintosh. This tool can find and repair 
many basic directory structure problems and 
help keep your drives functioning properly. 

Use Disk First Aid when your system reports 
drive errors or when files on the drive cannot be 
opened or used by Digidesign software applica-
tions. You may also wish to use Disk First Aid 
regularly to prevent drive problems before they 
occur. 

You can usually find a copy of Disk First Aid in 
one of the following locations:

◆ The Utilities folder on your system drive

◆ The system software CD-ROM included with 
your Macintosh computer

Repairing DigiDrives with Disk First Aid

To repair a DigiDrive:

1  Launch the Disk First Aid application.

2  Select the drive you want to verify and repair 
by clicking on the drive icon in the Drive Selec-
tion window.

Disk First Aid
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3  Verify and repair the selected drive by clicking 
the Repair button. Disk First Aid scans the direc-
tory structures, reports any problems, repairs 
the selected drive (if possible), and reports the 
results.

4  If Disk First Aid reports that the selected drive 
cannot be verified or repaired, follow the steps 
in “If Drive Status Cannot Be Verified” on 
page 15.

5  Choose Quit from the File menu when you are 
finished.

If Drive Status Cannot Be Verified

If Disk First Aid is unable to verify or repair a 
DigiDrive:

1  If possible, copy all media files and other data 
files to another drive.

2  Try using Norton Disk Doctor to repair the 
drive. See “Using Norton Disk Doctor” on 
page 15.

If you are still experiencing problems or are un-
able to repair the drive, contact Digidesign 
Technical Support for additional assistance.

Using Norton Disk Doctor

Norton Disk Doctor is a third-party application 
for diagnosing and repairing drive problems. 
Norton Disk Doctor provides more comprehen-
sive coverage of drive problems than Disk First 
Aid, and can repair directory structure and file 
problems that Disk First Aid cannot repair. You 
should run Norton Disk Doctor regularly to help 
prevent drive problems before they occur.

Use Norton Disk Doctor version 6.0 or 
higher with DigiDrive FireWire drives. Ear-
lier versions do not support FireWire drives. 
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Copy Norton Utilities® onto one or more of the 
drives on your system before you continue with 
the following sections. You may want to copy 
Norton Utilities into the Utilities folder with 
Disk First Aid for convenience.

Repairing DigiDrives with Norton Disk 
Doctor

To repair a DigiDrive:

1  Launch Norton Utilities.
.

2  Select Norton Disk Doctor.

3  Follow the instructions in the Using the Norton 
Utilities manual for drive repair and recovery. 

4  Attempt to repair all problems noted by 
Norton Disk Doctor. Follow any special instruc-
tions or recommendations that Norton Disk 
Doctor provides.

5  When Norton Disk Doctor is finished, click 
Show Report to see a listing of the problems that 
were found with the drive, or click Done to re-
turn to the Norton Disk Doctor window.

You should perform a custom installation 
of the Norton Utilities to copy only the Re-
pair and Recovery utilities and the Startup 
Disk Builder. Other functions in the Norton 
Utilities can cause conflicts with Digidesign 
software. 

Norton Utilities Main menu
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6  Repeat steps 3 and 5 to make sure the prob-
lems were fixed.

7  Choose Quit from the File menu when you are 
finished.

Troubleshooting
In some cases, you may have problems with a 
DigiDrive that you can correct on your own. Fol-
lowing are solutions to common problems.

DigiDrive Does Not Turn On

If a DigiDrive does not turn on after you press the 
power switch:

1  Make sure the AC power cord is securely con-
nected to the drive enclosure.

2  Make sure the drive is plugged into a power 
strip or a wall outlet.

3  If the drive is plugged into a power strip, make 
sure the power strip is plugged into a wall outlet 
and that the power strip is turned on.

After you turn on the drive, the green power 
LED on the front of the drive is lit.

After using Norton Disk Doctor and Disk 
First Aid for drive repair and recovery, back 
up your data and reinitialize your drive as 
soon as possible.



DigiDrive Does Not Appear on the 
Desktop

If a DigiDrive icon does not appear on the desktop:

1  Make sure the drive turns on. Follow the in-
structions in “DigiDrive Does Not Turn On” on 
page 16 if the drive does not turn on.

2  Make sure all the cables are properly con-
nected. For cable and setup information, see 
“Connecting Cables” on page 9.

3  Once you've made sure that the drive is turned 
on and properly connected, try restarting the 
computer.

DigiDrive Produces Errors

If a DigiDrive is producing errors or is acting 
erratically:

1  Run Disk First Aid to repair any directory 
problems.

2  Run Norton Disk Doctor to fix any bad block, 
folder, and file problems.

3  Use Norton Utilities to rebuild the drive’s 
desktop (the files that maintain the record of 
what is on the drive).

4  Contact Digidesign Technical Support if you 
need additional assistance.
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Computer Fails to Start Up

If your computer fails to start up:

1  Make sure all Digidesign cards and SCSI accel-
erator cards are properly seated.

2  Check that all SCSI devices on the bus have a 
unique SCSI ID. Duplicate SCSI IDs cause system 
problems.

3  Make sure all SCSI and FireWire cables are 
properly connected.

4  Check that the SCSI bus is properly termi-
nated.

5  If the computer still does not start up or if it 
hangs, disconnect all drives and try to start up 
the computer. If the computer then starts up, a 
drive, cable, or a SCSI terminator may be defec-
tive. 

6  See the setup guide that came with your com-
puter for additional troubleshooting informa-
tion.

7  Contact Digidesign Technical Support if you 
need additional assistance.
ng and Maintaining DigiDrive FireWire Drives on Mac OS 17
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chapter 6

Formatting and Maintaining DigiDrive 
FireWire on Windows 2000
To use your DigiDrive on a computer running a 
Windows operating system, you must first for-
mat and partition the drive. Once you have 
done this, you can keep your DigiDrive in peak 
operating condition by performing mainte-
nance operations and checks on a regular basis. 

To help you do this, this chapter contains the 
following sections:

◆ Windows Drive Maintenance Software

◆ Partitioning Drives

◆ Creating Primary Partitions and Formatting 
Drives

◆ Creating an Emergency Repair Disk

◆ Keeping Your Hard Drive Tuned Up

◆ Troubleshooting
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Windows Drive Maintenance 
Software
Windows allows you to create multiple parti-
tions on a single drive as a way to manage 
projects and files. This section helps to clarify 
the function of partitioning a drive and other 
features related to drive performance. 

The following list provides some information 
concerning partitions and disk devices on Win-
dows systems:

◆ You can partition your drive as one primary 
partition, having the partition represented by a 
drive letter. 

Pro Tools does not support extended parti-
tions or logical drives on the DigiDrives.

One partition per physical drive

G

One partition (Drive G)
ng and Maintaining DigiDrive FireWire on Windows 2000 19



20
◆ Each partition is assigned a drive letter and 
cannot be further subdivided.

Choosing a File System

Windows 2000 supports the NTFS file system. 
Because NTFS offers security, improved file re-
covery, and integrated compression, you may 
want to use NTFS for partitions that will store 
system or applications data. However, it is 
strongly recommended that you use FAT 32 to 
format DigiDrive partitions intended to store 
digital sound data. 

Partition Size

Windows applications do not require specific 
partition sizes or file systems, so a wide range of 
partitioning schemes are possible. In general, 
smaller partitions offer somewhat better perfor-
mance, but the smaller the partition, the smaller 
the maximum file size. The largest FAT 32 parti-
tion allowed under Windows 2000 is much 
larger than the DigiDrive.

Partitioning Drives
The Windows 2000 operating system allows you 
to create multiple partitions or logical drive as-
signments as a way to manage projects and files. 
You can partition your drive as one large parti-
tion or multiple partitions varying in size. Each 
partition is assigned a drive letter.

Maximum partitions per physical drive

G H I J

Four partitions (Drives G–J)
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The Windows 2000 operating system defines 
two types of disk drives: 

• Basic disk drives allow disks to be divided into 
partitions. This type of drive is normally used 
for stand-alone disk drives in the Windows 
2000 operating system. 

• Dynamic disk drives allow disks to be divided 
into volumes. Disk drives must be dynamic if 
you want to stripe, mirror, or use disk drives in 
the RAID style. 

Creating Primary Partitions 
and Formatting Drives 
You may not have the same partitions and disk 
configuration given in the following procedure. 
However, examples in the procedure will help 
you understand the Windows 2000 Computer 
Management window.

To create a primary partition and format a drive:

1  Start your system and log in to an account 
with administrative privileges. 

2  Right-click the My Computer icon and choose 
Manage from the pop-up menu. The Computer 
Management window opens.

Use Basic disk type for DigiDrive FireWire 
drives.

Computer Management window



3  Click the Disk Management folder.

4  Beneath the disk name (at the left of the disk), 
the display indicates whether the disk is “Basic” 
or “Dynamic.” Pro Tools does not support Dy-
namic disks. If the disk is dynamic, right-click 
the drive name and choose Upgrade To Basic.

5  Place the mouse cursor over the DigiDrive, 
right-click, and select the “Create partition” op-
tion. The Create Partition Wizard window opens 
and explains the function of the wizard.

6  Click Next. The wizard leads you through par-
titioning and formatting of the selected unallo-
cated section of your disk. 

7  In the Select Partition Type window, select Pri-
mary, and click Next.

8  In the Partition Size window, select Maximum 
to make the complete unallocated space a parti-
tion, and click Next. To make a smaller parti-
tion, divide the maximum number by the 
number of partitions you want to make, for a 
maximum of four partitions per disk. You need 
to run the wizard for each partition.

9  In the Assign Drive Letter window, assign the 
partition an unused drive letter or use the letter 
automatically selected by the wizard.

For more information on the Computer 
Management window, click the Help icon in 
the toolbar of the Computer Management 
window.
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10  In the Format Partition window, select the 
“Format this partition with the following set-
tings” option.

11  Choose FAT 32 from the File System to Use 
pop-up menu.

12  Choose Default from the “Allocation unit 
size” pop-up menu.

13  Type a label you want for the volume that 
easily identifies the volume in the “Volume la-
bel” text box.

14  Select the Perform a Quick Format option.

15  Click Next. 

16  The Completing the Create Partition Wizard 
window opens and provides a list of your selec-
tions. 

17  Verify your selections and click Finish (this 
might take a minute to complete). 

18  Repeat this procedure to partition and for-
mat any unallocated disk sections.

Format Partition window
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Creating an Emergency Repair 
Disk
The Repair Disk utility saves all of your current 
system settings to an Emergency Repair Disk. 
You can then use this disk to restore your com-
puter if files become damaged.

Store the repair disk until needed. If you have a 
problem, search for Emergency Repair Disk in 
the Windows Help.

To create a repair disk in Windows 2000:

1  Go to Start > Programs > Accessories > System 
Tools. Click Backup.

2  In the Tools menu, click Create an Emergency 
Repair Disk. Follow the instructions that appear 
on your screen. 

3  Check “Back up the registry to the repair 
disk.”

Saving the Disk Configuration

This operation saves configuration information 
about currently defined drive letters.

To learn how to create a configuration floppy 
disk in Windows 2000, see your Windows 2000 
Help Guide.

Create and update an Emergency Repair 
Disk each time you make significant 
changes to your hardware or software setup.

You will need a blank, PC-formatted, 
1.44 MB floppy disk to create an Emergency 
Repair Disk

The repair process relies on information 
that is saved in the systemroot\repair 
folder. Do not change or delete this folder. 
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Keeping Your Hard Drive 
Tuned Up
Keeping your hard drives in good operating con-
dition is essential. Following are steps that you 
can take to ensure that your DigiDrive contin-
ues to provide optimum performance.

Avoiding File Fragmentation

What is fragmentation? In multitrack recording, 
audio tracks are written in discrete files, spaced 
evenly across the disk. If the space required to 
write a discrete file is not available in a single 
contiguous block, the file is broken up into sev-
eral file fragments. This distribution of files and 
file fragments in blocks spread out over the sur-
face of hard drive disks causes playback to be-
come increasingly seek-intensive. The decrease 
in performance due to this process is continuous 
and progressive. As you add new sound files and 
edit existing files, the hard drive becomes in-
creasingly fragmented.

Defragment your drives To correct fragmentation 
and to prevent this gradual decrease in hard 
drive performance, use one of the hard disk 
maintenance utilities (for example Symantec’s 
Norton Speed Disk and Executive Software’s Dis-
keeper). These utilities will allow you to reas-
semble file fragments and reorganize discrete 
files so they are contiguous. 



How often? If you use your system for intensive 
editing, or if you frequently delete audio or fade 
files from your hard drive, you may need to op-
timize your drives on a weekly basis, or even ev-
ery few days, since it doesn’t take long for even 
a large hard disk to become fragmented.

Correcting Disk-related Errors

With continued use, a hard drive’s file system 
can become corrupted. The best defense against 
this corruption is regular use of a disk repair util-
ity, such as Norton Utilities. 

If you are getting disk errors that cannot be re-
solved through the use of the disk repair utilities 
the most decisive way to resolve file system cor-
ruption is to back up your data, reformat the 
drive, and restore the data. 

While Symantec and Executive Software 
both claim that the use of their products 
does not endanger the integrity of hard drive 
data, you should always back up your data 
before defragmenting or reorganizing files 
and directories on your hard drive. Use a 
disk repair utility (such as Norton Utilities) 
to find and correct file system errors prior to 
defragmentation. Make sure the disk repair 
utility supports FireWire (IEEE 1394) 
drives, or permanent data loss may occur.

The term “reformat” refers to a high-level 
format, as performed by Windows 2000's 
Disk Management utility. This process 
erases all data and recreates the file system, 
but does not affect low-level sector and track 
information. 
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Troubleshooting
In some cases, you may have problems with a 
DigiDrive that you can correct on your own. Fol-
lowing are solutions to common problems.

DigiDrive Does Not Turn On

If a DigiDrive does not turn on after you press the 
power switch:

1  Make sure the AC power cord is securely con-
nected to the drive enclosure.

2  Make sure the drive is plugged into a power 
strip or a wall outlet.

3  If the drive is plugged into a power strip, make 
sure the power strip is plugged into a wall outlet 
and that the power strip is turned on. After you 
turn on the drive, the green power LED on the 
front of the drive is lit.

DigiDrive Produces Errors

If a DigiDrive is producing errors or is acting 
erratically:

■ Check the Event viewer for drive-specific er-
rors. The Event viewer is located under Disk 
Management for Windows 2000. 

For information on using the Event viewer, see 
your Windows operating system documenta-
tion. 
ng and Maintaining DigiDrive FireWire on Windows 2000 23



24
Computer Fails to Start Up

If the computer fails to start up:

1  Check that all SCSI devices on the bus have a 
unique SCSI ID. Duplicate SCSI IDs cause system 
problems.

2  Make sure all SCSI and FireWire cables are 
properly connected.

3  Check that the SCSI bus is properly termi-
nated.

4  If the computer still does not start up or if it 
hangs, disconnect all SCSI and FireWire drives 
and try to start up the system. If the computer 
then starts up, a drive, cable, or SCSI terminator 
may be defective. 

5  Refer to the setup guide that came with your 
computer for additional troubleshooting infor-
mation.

6  Contact Digidesign Technical Support if you 
need additional assistance.
DigiDrive FireWire Guide



appendix a

Specifications

The following sections provide dimensions and weights, and environmental, power supply, and 
power cord specifications for the DigiDrive FireWire drive.

Dimensions and Weights
Dimensions and weights
Topic Specification

Width:
without interlock stacking brackets 
with interlock stacking brackets

7.50 in (190.5 mm)
8.18 in (207.7 mm)

Height
without interlock stacking brackets 
with interlock stacking brackets

2.69 in (68.3 mm)
3.12 in (79.2 mm)

Depth
without interlock stacking brackets 
with interlock stacking brackets

9.85 in (250.2 mm)
9.85 in (250.2 mm)

Weight
without interlock stacking brackets 
with interlock stacking brackets

4.4 lb (2 kg)
4.5 lb (2.1 kg)
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Environmental Specifications
Environmental specifications 
DigiDrive FireWire Guide
Topic Specification

Room temperature 95°F (35°C) maximum

Operating humidity 5% to 90% noncondensing

Storage temperature –40°F to 149°F (–40°C to 65°C)

Storage humidity 5% to 95% noncondensing
Power Supply Specifications

Operating the drive at room temperatures 
higher than recommended will cause the 
drive to age prematurely and void your war-
ranty.

Power supply specifications

Topic Specification

Voltage 100 to 240 V ac autosensing

Frequency 50 to 60 Hz

Watts 10 W (typical)
30 W (maximum)



Power Cord Specifications
Choose the power cord according to the country 
destination; it must comply with local safety re-
quirements. Use the guidelines in the following 
sections to replace the original power cord.

CEE-22 Power Cord Requirements

The female receptacle of the cord set, shown be-
low, must comply with CEE-22 requirements.

United States and Canada Power 
Cord Requirements

In the United States and Canada, the male plug 
is a NEMA 5-15P style and is UL listed and CSA 
certified. SVT cord can be used with desktop or 
stackable units; all other equipment requires SJT 
cord. Only SJT-type cord sets can be used for 
units that rest on the floor. 

United States and Canada power cord requirements

Select the cord set according to the current rat-
ing of your unit. See Table 5 for the selection cri-
teria for power cords in the United States and 
Canada.

Receptacle (CEE-22)

Cord Type Size of Conductors 
in Cord

Maximum 
Current Rat-
ing of Unit

SJT 16 AWG 12 A

SVT 18 AWG 10 A

SVT 17 AWG 12 A
European Countries Power Cord 
Requirements

In Europe, use only an H05VV-F, <HAR>, VDE, 
PVC, 3 x 1.00 mm 2 power cord (“NEMA 5-15P 
Style Plug”). Für den Gebrauch in Deutschland 
muß ein Netzkabel des TypsH05VV-F, <HAR>, 
PVC, Größe, 3 x 1.00 mm 2verwendet werden.

United States and Canada Power 
Cord Requirements

In the United States and Canada, the male plug 
is a NEMA 5-15P style and is UL listed and CSA 
certified. SVT cord can be used with desktop or 
stackable units; all other equipment requires SJT 
cord. Only SJT-type cord sets can be used for 
units that rest on the floor. 

European power cord requirements

NEMA 5-15P style plug

Cord 
Type

Size of Conductors 
in Cord

Maximum Cur-
rent Rating of 
Unit

SJT 3 x 1.00 mm2 10 A

SVT (not applicable) (not applicable)
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